SCOPE OF WORK



PROJECT NAME
ROUTE AND NUMBER
Scoping
[image: Blue TriScallion - Black DOT Lettering]





Federal Highway Administration
Central Federal Lands Highway Division



A/E Consulting Engineering Contract
Engineering Services






FIRM NAME






[bookmark: _Hlk98227447]Task Order Number: 6982AFXXD0000XX/T-0X-0XX
Modification Number
June 15, 2022


CFL Internal Projects:  Delete all blue text
A/E Delivered: Delete all green text
Hidden Text:  To turn on/off; 1) select ¶ from the toolbar to toggle or 2) Tools>Options>View>Formatting Marks – Select/deselect hidden text.  Will not print unless Print>Options>Hidden Text is selected
******Delete this text box prior to finalizing SOW*******

1. GENERAL INFORMATION

INTRODUCTION
	Guideline: Provide a general description of work included with only enough detail for the Consultant/Designer to recognize generally what is included. Text below is sample only. KEEP IT SHORT!


This Scope of Work (SOW) is to perform environmental, engineering, hydraulic, geotechnical, right-of-way, surveying, mapping, and project management services towards delivery of a 30% plan set for the Federal Highway Administration, Central Federal Lands Highway Division (CFLHD) for proposed improvements to California Forest Highway 114, Hyampom Road.

PROJECT SUMMARY
	Guideline: Describe the background, location, and overall goal of the project.  Provide enough historical information so the Consultant/Designer can understand the requirements and how this SOW supports the overall project goal.  Identify any previously completed work that has been completed that will assist the consultant in understanding the project, including work on the environmental document.  Describe the location well enough so that the Consultant/Designer can plan how to get to the project and where to stay.  Also include where the project starts and stops, if applicable. Text below is sample only.


The Federal Lands Highway, Forest Highway program, provides funding for this project.  In January 1997, the Federal Highway Administration (FHWA) issued an environmental assessment that the proposed improvements would have no significant impact on the human or natural environment. This Finding of No Significant Impact (FONSI) is for the entire FH-39 route.  Project design standards were finalized in the FONSI.

Utah Forest Highway (FH) 39 begins at the intersection of FH 42 (Fremont River Road) and FH 13 (Fish Lake Road) and proceeds northward for 47.5 kilometers (29.5 miles) along Sevenmile Creek and Gooseberry Creek to its junction with Interstate 70. The junction is approximately 11.3 kilometers (7 miles) east of Salina, Utah.  The route is primarily on Federal land within the Fishlake National Forest in Sevier County. The road is maintained by Sevier County. The first phase (Phase 1) of the route provides for the reconstruction of 21.9-km (13.5 miles) of FH 39, from just south Twin Ponds Road to just south of the I-70 interchange. This project is currently under construction.

This second phase (Phase 2) will continue from Twin Ponds south toward the junction of FH-42, Fremont River Road. The second phase will cover about 14 km (9 miles). The Phase 2 segment of the route is currently funded for design and construction, with construction scheduled to begin in the Spring 2005. The third phase of the project (Phase 3) will be the completion of the route.  Phase 3 is programmed for construction in fiscal year 2007. 

The proposed road reconstruction will closely follow the existing road with widening as appropriate to improve safety and minimize impacts.  The Phase 2 portion of the route includes two realignment segments, known as the Switchbacks and Salina Reservoir. The reconstruction will improve the alignment, grade, and width to appropriate current standards. The project includes grading, drainage structures, subsurface drainage, placement of crushed aggregate base and asphalt pavement, signing, striping, guardrails, and other safety-related features necessary to meet current design practice.

SCOPE
	Guideline:  State the project purpose and specific objectives to help the Consultant/Designer understand the size or magnitude of the anticipated effort.  This will define the differences between Refuge Road, 3R, and 4R projects and let the consultants know what we want.  For example in design this is where we define our expectations for “tweaking” the alignment to lay lightly on the land, fit terrain, etc on 4R projects. Identify the primary stakeholders/cooperating agencies. Text below is sample only.


The general scope of roadway improvements is programmed as recycling and overlay of surfaces on 7.2 miles of Highway 87 and 1.4 miles of the north and south access roads to the Visitor’s Center parking lot.  Guardrails are also to be upgraded to meet new standards.  The Beaver Creek Bridge is also to receive rehabilitation work in the form of installing expansion joint seals and a new wearing surface, repairing damaged and deteriorating concrete railing and curbs, repairing undermined abutments and wing walls, and installing slope protection.  These improvements will be designed and implemented in accordance with National Park Service, CFLHD, and AASHTO Highway Design Standards, in cooperation with the National Park Service, Denver Service Center and Wind Cave N.P.

WORK REQUIRED
	Remove following two paragraphs for internal work


The work shall be performed by Consultant (referred to as the A/E) or its approved designated representative. The A/E work shall be performed and/or directed by the key personnel identified in the A/E proposal. Any changes in the indicated key personnel or the A/E officer-in-charge of the work, as identified in the A/E proposal, shall be subject to review and approval by FHWA.

Subconsultants not identified in Contract 6982AFXXD0000XX will require approval by the FHWA Acquisitions office prior to beginning work. These subconsultants will be required to submit the same information regarding their firm as those identified in the original contract. 

0. PROJECT DEVELOPMENT PLANNING
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Project Delivery Plan and Endorsement (P6 Activity P1)
This activity is the starting point for all projects.  Included are the tasks related to Interdisciplinary/Environmental scoping, pre-construction work planning, scheduling and budgeting.  A good working draft of the Project Agreement is developed.   
	The following list of typical tasks is based on and supplement the documents referenced in Section V of this SOW and the CFLHD Standard P6 Template Activities.  However, it may be appropriate to add, delete, or modify tasks to meet project specific requirements.

For CFL internal projects this activity can be done as a separate SOW during scoping.



0. Kick-off Meeting
0. Pre-scoping Preparation 
1. Gather preliminary project information as described in the scoping report or equivalent document
1. Submit electronic copy of project information to the CFLHD Project Manager when complete
0. Post Scoping Trip Meeting
· Review findings and summarize to team
Draft Project Delivery Plan for the project. The Project Delivery Plan should include the following:
Scoping Summary
Follow the CFLHD Scoping Summary Outline (1-2 page summary document)
Design Scoping Report
Follow the CFLHD Scoping Report Outline
Address all Project Development issues listed in the outline and recommend the work to be accomplished
Include recommended Utility Data Quality Level 
Draft Project Agreement
Summarize the key issues associated with the work
Highlight the key elements
Show a draft schedule of all milestone activities through completion of construction. 
Preliminary cost estimate
Show all major work items and include a contingency appropriate for the project
Refer to CFLHD’s Engineer’s Estimate Manual for development of the cost estimate.
Preliminary construction schedule
Identify the major construction bid items, develop the production rates/durations and develop the construction schedule.
Comprehensive Scope of Work (SOW) for the entire project detailing all work tasks to be accomplished
Comprehensive Preliminary Engineering Budget
Develop a detailed PE budget to fully estimate design effort through 100% PS&E development
Provide only a high-level rolled up cost with costs broken out at the discipline level and not the full detailed estimate.
Baseline schedule using work activities consistent with CFLHD’s Project Resource Management System (P6) 
Communications Plan
Identify information needs, frequency of contact and the medium for communications.
Risk and Opportunity Management Plan
Summarize the potential threats and opportunities for the project
Include projected responses to each threat and opportunity.
Procurement Plan (if needed) for unique project situations such as Best Value, emergency situations or Design/Build
Other Project Documents including (as applicable):
Photo Log
Culvert Summary
Sign Summary
Utility / ROW Cooperator Agreements
Other project specific documentation
Project Delivery Plan Review Meeting
Review Project Delivery Plan including Scope, Schedule and Budget with CFT/PST
Finalize and Endorse Project Delivery Plan
Incorporate comments and changes recommended by CFLHD.
Produce final document for distribution to all Project Team Members. 
	Following bullets are for CFL Internal Projects ONLY.  PM will obtain endorsement from MB and submit to P6 for AE Projects.


Obtain endorsement from all CFT members on Project Delivery Plan
Submit approved SOW, schedule, and budget to P6.


Deliverables for P1 Activity
	Add/delete deliverables to correspond to the tasks above.  Coordinate number of copies with COTR/PM.  Number of copies and submittal dates shall be shown in Section IV, Deliverables and Schedule.


DRAFT Project Delivery Plan
FINAL Project Delivery Plan

PROJECT MANAGEMENT
	The following list of typical tasks is based on and supplement the documents referenced in Section V of this SOW and the CFLHD Standard P6 Template Activities.  However, it may be appropriate to add, delete, or modify tasks to meet project specific requirements.


Project Management will continue throughout the duration of the project.  It includes, but is not limited to, all work necessary to manage production efforts, coordinate with CFLHD, administer this contract and monitor progress.

While performing the work described under this task order, discussions with people from other agencies (i.e., USFS, NPS, FWS, and other personnel or consultants) as well as other CFLHD employees will be required.  Participate freely in these discussions, answer questions and respond to requests for information.  Maintain records of these discussions and keep the COR informed of any pertinent information.  However, do not accept any direction or take additional work that is beyond the scope of this task order.  During discussions with partner agencies do not suggest performance of additional work that is beyond the scope of this task order. The FHWA Contracting Officer is the only representative that has the authority to revise or add work under the requirements of this task order.

Project Management (P6 Activity PM)

0. Project Management oversight.  Typical activities include, but are not limited to, the following:
Identify the project requirements and determine complexity of the work, technical activities, schedules and resources
Administer project contract and monitor progress
Discuss and coordinate project requirements with the Contracting Officer’s Technical Representative (COR) and designated project team contacts
Prepare and maintain project design files & supporting documentation for correspondence, reports, design details and calculations of quantities that are included in the plans.
Submit monthly progress reports providing a summary of:
Previous month’s accomplishments and activities
Overall progress achieved toward completion of the task order
Future month expectations
Any issues or action items that need to be resolved or addressed with CFLHD or partner agencies
All activities that will be undertaken during the succeeding month
Submit a progress report with each invoice
	Check with the PM to determine if the following step should be included



Include Step 3 if there will be a subconsultant for the scoping and PDP activity. (Delete this note). 
Step 4. Provide subconsultant management for all subconsultants performing work
· Manage all aspects of the selection, procurement, administration, and closeout of each subconsultant contract.


Deliverables for Project Management
	Add/delete deliverables to correspond to the tasks above.  Coordinate number of copies with COTR.  Number of copies and submittal dates shall be shown in Section IV, Deliverables and Schedule.


Meeting Minutes
Initial CPM Schedule and Revised Schedules
Discussion Notes
Monthly Progress Reports and Invoices

SITE VISITS

Step 1. Scoping Site Visit (P1SV Activity)


Deliverables for Meetings and Field Reviews
	Add/delete deliverables to correspond to the tasks above.  Coordinate number of copies with COTR/PM.  Number of copies and submittal dates shall be shown in Section IV, Deliverables and Schedule.


· Meeting notes

III.  FHWA FURNISHED PROPERTY/DATA

CFLHD will provide the following to facilitate successful completion of the project.  The A/E shall notify the COR of apparent errors and omissions discovered in the data supplied.  

General Data:
· Design Scoping Report Outline – FLH Webpage 

IV.  DELIVERABLES AND SCHEDULE

	Milestone Activity Schedule

	Milestone
	Completion Date

	Kick-off Meeting
	

	Scoping Site Visit
	

	DRAFT Project Delivery Plan
	

	FINAL Project Delivery Plan
	

	
	



V.  WORK PERFORMANCE SPECIFICATIONS, QUALITY STANDARDS AND REPORTING REQUIREMENTS

The proposal should include the information described under Section C, Article II.D and E of the contract, including a fee proposal itemized for activities listed under II. Work Required, and a discussion of methods used to accomplish any work element that is not fully understood or not adequately described in this Scope of Work (SOW).

This Task Order does not include payment for errors and/or omissions by the A/E in the course of performing the work herein. Such errors and omissions are to be corrected at the A/E’s expense.
	
Each product is expected to meet an Acceptable Quality Level (AQL) with respect to the thoroughness and appropriateness of the data collection, analysis and recommendations, the clarity of presentation, and the accuracy of the completed products.  Work conducted according to guidelines recommended in the PDDM and documents referenced below, and satisfying any specific requirements of this SOW, will meet the thoroughness, appropriateness and clarity criteria of the AQL.  Where the Standard of Practice within CFLHD currently differs from the PDDM, work should follow the current Standard of Practice.  The A/E contractor should assure work products are accurate and of high quality through an established and documented quality control and assurance (QA) process.  CFLHD staff will be responsible for evaluation of the quality of work throughout this project.  CFLHD Staff will participate in correspondence, meetings, site visits, and review of products.  CFLHD review is not QA of the A/E’s work; the purpose is to understand the product and to impart CFLHD institutional experience with the site, customer, project features and potential construction contractors.  Also, CFLHD review is to evaluate the level of risk taken by the government (which is implied by the type of investigation and analysis conducted, the selected design criteria, and the quality of the A/E contractor’s products) and to evaluate if that level of risk is consistent with other similar CFLHD projects and/or is planned for.

[bookmark: _Hlk93053011]All public-facing electronic products developed must be accessible to persons with disabilities, including those with vision, hearing, cognitive, and mobility impairments.
Applicable Standards include:

· Appendix A to Part 1194 – Section 508 of the Rehabilitation Act: Application and Scoping Requirements
· Appendix C to Part 1194 – Functional Performance Criteria and Technical Requirements  

Anticipated documents that need to comply with Section 508 include:

· 

Written documents to be provided to FHWA related to this project will be delivered in electronically.  Documents will be provided in the following software formats unless specifically amended otherwise by the COR in writing:

	   Application				    Software
	
	Word Processing				Microsoft Word
	Spreadsheet					Microsoft Excel
	CADD						MicroStation
	Highway Design					OpenRoads
	
The baseline technical standards and guidelines to be used on this project are as follows:

Geotechnical:

· Electronic versions of geotechnical documents, if available, can be found on CFLHD Webpage 
· FHWA-HI-97-021: Geotechnical and Foundation Engineering Module 1 - Subsurface Investigations  
· FHWA-NHI-00-043: Mechanically Stabilized Earth Walls and Reinforced Soil Slopes Design and Construction Guidelines, 2001
· FHWA-SA-97-070: Micropile Design and Construction Guidelines – Implementation Manual, 2000
· FHWA-IF-03-017: Geotechnical Engineering Circular No. 7 – Soil Nail Walls, 2003
· FHWA-IF-99-015: Geotechnical Engineering Circular No. 4 – Ground Anchors and Anchored Systems, 1999

FHWA Checklist and Guidelines for Review of Geotechnical Reports and Preliminary Plans and Specifications on CFLHD Webpage. 

Pavements:
· Specific Technical and Reporting Requirements - CFLHD Webpage 
· AASHTO Guide For Design of Pavement Structures (1993 edition)
· Basic Asphalt Recycling Manual, 2001 Edition, FHWA NHI 01-22
· Techniques for Pavement Rehabilitation, FHWA-HI-98-033
Highway Design:
· Manual on Uniform Traffic Control Devices (MUTCD).  DOT, FHWA, Latest Edition, including all errata.  http://mutcd.fhwa.dot.gov/
· A Policy on Geometric Design of Highways and Streets, AASHTO, Latest Adopted Version
· Roadside Design Guide, AASHTO, Latest Edition
Bridge/Structure Design:
· AASHTO LRFD Bridge Design Specifications –   5th Edition, 2010, with current interim revisions.  
· AASHTO Standard Specification for Highway Bridges - 17th Edition, 2002
· Manual for Condition and Evaluation and Load and Resistance Factor Rating (LRFR) of Highway Bridges, 2003, with current interim revisions. 
· Submit the following items in a bound format other than D-ring binders:
· Structure selection report
· Design notes
· Independent check notes
· Load rating
· Structural quantities and unit cost analysis
· Provide CADD bridge drawings electronically.  Provide drawings with true scales on 11x17 size sheets, reference files detached, and with A/E contractor logo and PE stamp on all plan sheets.
General:
· Latest Federal Lands Highway Project Development and Design Manual (FLH PDDM) -   CFLHD Webpage
· CFLHD division procedures available via CFLHD Project Development Home Page - CFLHD Webpage
· CFLHD CADD Manual and Sample Plans - CFLHD Webpage
· Standard Specifications for the Construction of Roads and Bridges on Federal Highway Projects, FP-24
· CFLHD Guidance for Sealing and Signing Documents - CFLHD Webpage

While this list is not all-inclusive, the publications listed will provide the A/E with enough information to understand this scope of work.

VI.  PERIOD OF PERFORMANCE

Work will begin immediately after award of the task order to the A/E and all work will be completed by Month, Date, Year.  

VII.  CONTRACTING OFFICER’S TECHNICAL REPRESENTATIVE & PROJECT SUPPORT TEAM (PST)

Close and continuous coordination with the COR and other FHWA personnel with special expertise will be required. All communications affecting the project will be through the COR.

The COR for this task order will be Mr./Ms.            .  Mr./Ms. can be reached at the following address:  

FHWA-CFLHD, HFPM-16
12300 W. Dakota Ave., Suite ###
Lakewood, CO  80228
(720) 963-3###, FAX (720) 963-3###
Email: first.last@dot.gov

FHWA-CFLHD Project Support Team
Project Manager:
Utilities/ROW Documents:
Environment/Permits:
Survey:  
Geotechnical:  
Pavements:  
Hydraulics:  
Highway Design:  
Bridge Design:
Construction:
QA/QC:
Safety:  


VIII.  PAYMENT

Payment will be made on a firm-fixed-price basis in accordance with ARTICLE V, CONSIDERATION AND PAYMENT, covered under contract 6982AFXXD0000XX.

Payment will be made 30 days after the designated billing office receives a proper invoice and progress report from the contractor.

Submit invoices to:

The Department of Transportation utilizes the Delphi e-Invoicing web-portal for processing invoices.  Submit invoices via Delphi e-Invoicing which is accessed and authenticated via www.login.gov 

FHWA reserves the right to terminate this contract for the convenience of the Government at any time.  Reasons for termination may include, but are not limited to, Federal Lands Transportation Program (FLTP) changes which result in no further funding for the project, a NEPA decision resulting in a no-action alternative or loss of project support from partner agencies.  
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